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TIME AND LABOR 
 

BUSINESS PROCESS FLOW 
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> Weekly Elapsed Time  
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Capture Time and Labor > 

Process > Time Administration 

 

 

 

 

 

 

Self Service > Manager > View 

> Manage Group Exceptions 

 

Self Service > Manager > View 

> Payable Time Detail 
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TIME AND LABOR CONCEPTS 
PeopleSoft Time and Labor is a software application with many features and functions that are integrated 
with the other PeopleSoft application (Human Resources, Base Benefits and North American Payroll) 
being implemented at the State of Oklahoma.  This training documentation will cover only those functions 
currently implemented. 
 
This training manual does not cover all possible scenarios you may encounter while using PeopleSoft 
Time & Labor. However, it does cover the most frequently encountered scenarios.  
 

TERMINOLOGY 
You will encounter several new terms as you work with PeopleSoft Time and Labor and the PeopleSoft 
system.  Below are the terms and their definitions: 
 
Weekly Elapsed Time – is an input screen into which you key or load time worked and/or time taken off 

for each employee. 
 

For people on Salary, you would enter only the exceptions because the system automatically 
generates the entry to pay these employees for the whole month’s work.  
 
An example of exception time would be employee Joe Blow took off 8 hours sick on February 3.  
You must enter the correct TRC for sick time (SCKTK) and the number of hours taken on this 
page so that the system will move the 8 hours from the Regular Earnings category to the Sick 
Time category and reduce the employee’s sick time balance available. 

 
For hourly and temporary employees, you must key or load in the hours worked into Weekly 
Elapsed Time in order for them to get a paycheck.  The system does not enter anything 
automatically for these types of employees. 
 

 

NOTE: This page is always LIVE and can be changed at any time in the future. 
 The entries in it always stay there and the system knows which ones have already been paid and 

which ones are new entries that need to be paid. 

 
 
Time Administration – The batch program that takes time entered into Weekly Elapsed Time and 
validates it against pre-established rules and produces Payable Time if the time does not violate any of 
these rules.  If the time entered violates a rule, the system will not produce payable time for that time 
entry.  It also puts the time in violation of the rules into the Exceptions File and will not allow that entry to 
go any further until the exception has been cleared up.  The employee will not be paid for this time 
until the exception on it is cleared. 
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Payable Time – Time that has been processed through the Time Administration batch program. Payable 
Time can be pulled into Payroll for processing.  Only payable time can be sent over to payroll. 
 

Time & Labor Exceptions – an unusual condition.  It could be an error and must be checked out 
because the time that has the exception is hung up until the exception is cleared.  The employee cannot 
be paid for time that is flagged as an exception until that exception is cleared. 
 

Time Reporter – Any employee that has time processed through Time and Labor.  Every employee must 
be a time reporter to have time processed by Time Administration. 
 

Time Reporting Code (TRC) – A code that designates the type of work performed, leave time or other 
type of time that needs to be processed through Time and Labor.  Each agency will have several (usually 
100+) TRCs for entering time.  Examples are: LWOPS (Leave without Pay Scheduled), OTSTR (Overtime 
Straight), JURY (Jury Duty), SCKTK (Sick Time Taken), and ANNLV (Annual Leave Taken). 
 

Time Reporting Code Program (TRC Program) – Time Reporting Codes are grouped together into 
Time Reporting Code Programs so agencies will only see TRCs relevant to them when entering time for 
an employee.  The naming convention for TRC Programs has been defined as: 3 character agency + 01.  
Therefore, the TRC Program for Department of Mental Health is 45201. All agencies that have 
hourly/temp employees will use the TRC Program of HRLY. 
 

Workgroup – A group of employees that use similar data within the Time and Labor application.  Most 
agencies will have two Workgroups – one for salaried employees and one for hourly/temporary 
employees. 
 

SCOPE 
Now that we have some of the terminology down, let’s discuss what will be in scope for this phase of the 
implementation. 
 

� Ability to enter and report on time that is entered by type of work performed.  Meaningful reports 
can be generated for an agency to report across their employee base and get an understanding of 
how much Leave Without Pay is taken or how much Overtime is worked for example. 

 
� Various leave plans like Organizational and Military Leave, in addition to Compensatory Time Off 

plans have been established.  The plans have been created to automatically have time expire 
when it is supposed to and not allow accumulation of more time than is allowed. 

 
� Seamless integration with Base Benefits, Time and Labor and Payroll.  The integration ensures an 

employee has enough annual, sick or comp leave before the time entry page can even be saved. 
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CONFIGURATION 
To understand how transactions are processed through Time and Labor, it’s important to understand how 
the system was configured.  Each of the following sections indicates a part of the configuration.  It will all 
be tied together at the end of the section. 
 
Time Reporting Code – Time Reporting Codes are the level at which time is recorded.  An example of a 
Time Reporting Code is LWOPS – Leave Without Pay, Scheduled.  If an employee takes Scheduled 
Leave without pay, you will enter the number of hours that should be applied to this Time Reporting Code. 
 
Time Reporting Codes are: 

� Mapped to a Payroll Earnings Code to determine how this time will affect an employee’s pay, 
benefit accruals or other accumulators. 

� Designated as having an impact on Compensatory Time Plans, if appropriate. 
� Used for reporting purposes to determine trends or summary in type of work performed. 

 
The naming convention for Time Reporting Codes is to use up to five characters that describe the code as 
best as possible (i.e. LWOPS = Leave Without Pay – Scheduled). 
 
Time Reporting Code Programs – Time Reporting Codes are grouped together in Time Reporting Code 
Programs by agency.   
 
A Time Reporting Code is assigned at the Workgroup level (covered later).  This is helpful during time 
entry.  Rather than seeing all the Time Reporting Codes defined for all agencies, only Time Reporting 
Codes relevant to your agency will be available for entry.  An example of a Time Reporting Code Program 
is 54801. 
 
Each agency will have at least one Time Reporting Code Program for their full-time, salaried employees.  
If they have part-time, temporary employees they will have a second Time Reporting Code Program 
(HRLY). 
 
The naming convention for Time Reporting Code Programs is: 

• First three characters are the agency number 
• The last two characters are either “01” for full-time, salaried employees (80501) or “02” for special 

processing. 
• HRLY for part-time, temporary employees. 

 
Therefore, Rehabilitation services will have two Time Reporting Code Programs (80501 and HRLY). 
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Annual Leave and Sick Leave Plans are accrual-type plans.  They are tracked in Base Benefits.  The 
accrual process for these plans is run after all the payrolls for a given month are finished.  These plans 
have to be processed through a payroll before they can update the balances in Base Benefits. 
 
During the conversion process employees were enrolled in the same plans available to them in the legacy 
system and their balances were converted.  
 
In Time and Labor, the following plans have been established: 
 

� COMPCORE – Comp Core Project 

� COMPPUB – Compensatory Time Plan for Public Safety 

� COMPREG – Compensatory Time Plan for All others 

� COOLOFF – Administrative Leave, Cool Off – (32 hours) 

� ENFORCED – Enforced Leave – (80 hours) 

� HOLIDAY – Holiday Leave 

� MILITARY – Military Leave – (240 hours) 

� ORG – Organizational Leave – (24 hours) 

� SHARED – Shared Leave 

� SHLFTERM – Shared Lifetime Leave for Terminally Ill – (2920 hours which is 365 days) 

� SHLFNOTERM – Shared Lifetime Leave for Non-Terminally Ill – (2088 hours which is 261 days) 

 
Compensatory Time Off Plans – There are several Compensatory Time Plans that have been setup in 
Time and Labor. These plans have balances updated based on Time Reporting Codes entered for an 
employees time.  For example, an employee currently has a Compensatory Time Balance of 20 hours.  
This week we enter 8 hours using a Time Reporting Code that adds to the Compensatory Time Balance.  
The next time we process that time, the balance will get updated to 28 hours. 
 
 
Comp Time Data is all handled in Time & Labor – including the comp time balances. 
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Defining a Compensatory Time Off Plan 
 

Compensatory Time Plans have been established with limits and expirations as defined in the merit 
rules. 

 
Define Business Rules > Define Time and Labor > Setup 1 > Compensatory Time Off Plan 

 
 

 
 
In the screen print above, notice that a Compensatory Time Plan has been established called – 
COMPREG.  It says that Comp Time will expire in 180 days if not taken.  It also indicates that a person 
can only accumulate a maximum of 240 hours.  
 
Note:  Time is accumulated and taken on a first in, first out basis. 
 
The Time reporting Codes (TRCs) that update the Comp Plan Balance Record are shown on the next 
page. 
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 The bottom portion of the page shows the Time Reporting Codes that affect the balance. 
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Defining a Time Reporting Code (TRC) 
 
 
The time reporting code for Comp Time Earned is CTE.  The definition pages are shown below. 
 
Define Business Rules > Define Time and Labor > Setup 1 > TRC 
 
CTE Definition - TRC1 
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The second tab of the definition of the CTE Time Reporting Code - TRC2 is shown below. As it 
is defined, it adds to the Comp Time Balance. 
 
CTE Definition - TRC2 
 

 
 
Therefore, by including this Time Reporting Code in this plan it will add hours to an employees balance 
when time is entered against this Time Reporting Code. 

The hours will add to 

the Comp Leave 

Balance. 
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TRC Definition of Hourly (HREG) 
 

 
 

HREG Definition – tab TRC2 
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Time Reporting Codes for Agency 805 

TRC   Descr   
TRC 
Type   

Earn 
Code   

Comp 
Leave 

Ind   

Add 
to 

Gross 
ADJ   Earnings Adjustments   H   ADJ   NO   Y 
ADLAD   Admin Lv Cool Off Adjustment   H      CERN   Y 
ADLCO   Salary Admin Cool Off   H   ADL   CERN   Y 
ADMLV   Salary Administrative Leave   H   ADM   NO   Y 
ANNAD   Annual Leave Adjustment   H   ANA   NO   N 
ANNLV   Annual Leave Salaried   H   ANL   LTKN   N 
ANREC   Annual Leave Received   H   ANR   NO   N 
BOARD   Board Members and Commissioner   H   BRD   NO   Y 
BONE   Salary Regular Pay   H   SRG   NO   Y 
CADJ   Comp Rate Adj (Mid Week)   H   CAJ   NO   Y 
CAR   Vehicle Usage   A   CAR   NO   N 
CAREE   Career Progression   A   CRP   NO   Y 
CHARG   Charge Tips   A   CRT   NO   Y 
COMM   Commissions   A   COM   NO   Y 
CSI   Continuous Service Incentive   A   CSI   NO   Y 
CTE   Comp Time Earned   H      CERN   Y 
CTEAD   Comp Time Earn Adjustment   H      CERN   Y 
CTEH   Comp Time - Time and a Half   H      CERN   Y 
CTPO   Comp Time Payout   H   CTO   CTKN   Y 
CTT   Comp-Time Taken   H   CTP   CTKN   Y 
DALFY   Deceased Ann LV Follow Year   A   TVC   NO   N 
DBD   Refund From Unpurchased Bonds   A   DBD   NO   Y 
DBRFY   Deceased Bond Refund Follow Yr   A   TBD   NO   N 
DCTFY   Deceased Comp Time Follow Yr   H   TCP   CTKN   N 
DDCO   Dependent Care/other Cafe Plan   A   DCO   NO   N 
DDCR   Dependant Day Care Adj   A   DDA   NO   N 
DDPFY   Deceased Diff Pay Following Yr   A   TSH   NO   N 
DHLFY   Deceased Holiday Pay Follow Yr   H   THL   CTKN   N 
DISLV   Salary Regular Pay   H   SRG   NO   Y 
DLGFY   Deceased Longevity Follow Yr   A   TLG   NO   N 
DOTFY   Deceased O/T Follow Year   A   TOV   NO   N 
DPINC   Data Processing Signing Incent   A   DPI   NO   Y 
DRGFY   Deceased Reg Pay Following Yr   A   TEA   NO   N 
DTHCP   Deceased Comp Time   H   DCP   CTKN   Y 
DTHEA   Deceased Regular Pay   H   DEA   NO   Y 
DTHHL   Deceased Holiday Pay   H   DHL   CTKN   Y 
DTHLG   Deceased Longevity Payout   A   DLG   NO   Y 
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TRC   Descr   
TRC 
Type   

Earn 
Code   

Comp 
Leave 

Ind   

Add 
to 

Gross 
DTHOV   Deceased Overtime   H   DOV   NO   Y 
DTHSH   Deceased Shift Differential   A   DSH   NO   Y 
DTHVC   Deceased Annual Leave   H   DVC   NO   Y 
EDUC   Educational Leave   H   LED   NO   Y 
EEXPA   Employee Expense Allowance   A   EEA   NO   Y 
ENFAD   Enforced Leave Adjustment   H      CERN   Y 
ENFLV   Enforced Leave   H   ENF   CERN   N 
EQUIT   Equity Based Pay Adjustment   A   EBP   NO   Y 
EVA   EVE .12 HR (20.00 MO)   H   EVA   NO   Y 
FEEWV   Fee Waiver Tickets Misc   A   FTM   NO   N 
FLCT   FMLA Charged to Comp Time   H   FMC   CTKN   Y 
FMAL   FMLA Charged to AL   H   FMA   NO   Y 
FMDOC   FMLA Leave   H   FML   NO   N 
FMHL   FMLA Charged Holiday Pay   H   FMH   CTKN   Y 
FMSH   FMLA Charged Shared Leave   H   FMR   CTKN   Y 
FMSL   FMLA Charged Sick Leave   H   FMS   NO   Y 
FURLO   Furlough   H   FLW   NO   N 
GIVAN   Annual Leave Given   H   ANG   LTKN   N 
GIVSK   Sick Hours Given   H   SKG   LTKN   N 
GRAT   Gratuity Pay   A   GRT   NO   Y 
GTL   Group Term Life   A   GTL   NO   N 
HECR   Higher Ed Cafe Refund   A   HCF   NO   N 
HOLAD   Holiday Leave Adjustment   H      CERN   Y 
HOLDY   Holiday - Salary   H   HOL   NO   Y 
HOLPO   Holiday Payout   H   HPD   CTKN   Y 
HOLT   Holiday - Salary   H   HOL   CTKN   Y 
HOLWK   Holiday Worked   H      CERN   N 
HOUS   Housing Allowance   A   HOU   NO   Y 
HREG   Hourly Regular Pay   H   HRG   NO   Y 
INDIN   Individual Incentive   A   IDC   NO   Y 
JURY   Salary Regular Pay   H   SRG   NO   Y 
LATXF   Lateral Transfer Adjustment   A   LAT   NO   Y 
LONGO   Longevity Other-Dec, RIF, Ret   A   RLO   NO   Y 
LONGV   Longevity   A   LON   NO   Y 
LWOPE   Leave W/O Pay - Educational   H   DOC   NO   Y 
LWOPP   Leave Without Pay - Suspended   H   DOC   NO   Y 
LWOPS   Leave Without Pay - Scheduled   H   DOC   NO   Y 
LWOPU   Leave Without Pay - Unschedule   H   DOC   NO   Y 
LWPFW   Leave Without Pay W/C FMLA   H   DOC   NO   Y 



 

COR106 Time and Labor Manual Page 19 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

TRC   Descr   
TRC 
Type   

Earn 
Code   

Comp 
Leave 

Ind   

Add 
to 

Gross 
LWPMI   Leave Without Pay - Military   H   DOC   NO   Y 
MDA   MID .12 HR (20.00 MO)   H   MDA   NO   Y 
MEDR   Medical Reimbursement   A   MED   NO   N 
MILAD   Military Leave Adjustment   H      CERN   Y 
MILLV   Military Leave Salary   H   MLS   CERN   Y 
MISC   Miscellaneous (Contact OSF)   A   MIS   NO   N 
MOVE   Moving Expenses   A   MOV   NO   N 
MRKT   Market Adjustment Pay   A   MRK   NO   Y 
NATL   Salary Regular Pay   H   SRG   NO   Y 
NONDP   Non-DP Incentive   A   SIC   NO   Y 
ORGAD   Organizational Leave Adjustment   H      CERN   Y 
ORGD   Salary Regular Pay   H   SRG   NO   Y 
ORGLV   Organizational Leave Salary   H   OLS   CERN   Y 
OTHPD   Other Paid Leave   H   OTH   NO   Y 
OTPAY   Overtime @ 1.5x   H   OVT   NO   Y 
OTSTR   Overtime @ 1.0x (Straight)   H   OTS   NO   Y 
PERF   Perform Award NonDiscretionary   A   PRF   NO   Y 
PERFD   Perform Award Discretionary   A   PRD   NO   Y 
PROBA   Probationary Per Complete   A   PRB   NO   Y 
RADJ   Retro Pay Adjustment   A   RAJ   NO   Y 
RETPY   Retirement Pay   A   RTP   NO   Y 
SCKTK   Sick Leave Salaried   H   SKL   LTKN   N 
SEVRN   Severance Pay   A   SEV   NO   Y 
SHA   SHIFT .12 HR (20.00 MO)   H   SHA   NO   Y 
SHLAD   Shared Leave Adjustment   H      CERN   Y 
SHLGV   Shared Leave Given Back   H      CTKN   Y 
SHLNA   Shared Leave Non-Term Adjust   H      CERN   Y 
SHLNT   Shared Leave Non-Terminal   H      CERN   Y 
SHLTA   Shared Leave - Term ILL Adjust   H      CERN   Y 
SHLTR   Shared Leave - Terminally Ill   H      CERN   Y 
SHLVT   Shared Leave Taken   H   LVS   CTKN   Y 
SHP   SHIFT 2.00 HR (350.00 MO)   H   SHP   NO   Y 
SHREC   Shared Leave Rec   H      CERN   N 
SICAD   Sick Hours Adjustment   H   SCA   NO   N 
SICRC   Sick Leave Received   H   SKR   NO   N 
SLVER   OK Health Program - Silver   A   SLV   NO   Y 
STINS   State Insurance Cafe Refund   A   SCF   NO   N 
STUFD   Student Fund   A   STF   NO   N 
SUSPD   Suspended With Pay   H   SUS   NO   Y 
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TRC   Descr   
TRC 
Type   

Earn 
Code   

Comp 
Leave 

Ind   

Add 
to 

Gross 
TERM   Annual Leave Payout   H   ALP   NO   Y 
TIPAD   Tip Adjustments to Minimum   A   TAD   NO   Y 
TIPCA   Cash Tips   A   CAT   NO   Y 
TIPCR   Tip Credit   A   TRC   NO   N 
UNTIN   Unit Incentive   A   GRI   NO   Y 
VIS   Visual Care Reimbursement   A   VIS   NO   N 
VOLFF   Salary Regular Pay   H   SRG   NO   Y 
WCANN   Workers Comp - Annual Leave   H   WCA   NO   Y 
WCCMP   Workers Comp - Comp Time   H   WCC   NO   Y 
WCSCK   Workers Comp - Sick Leave   H   WCS   NO   Y 
WCSH   Sick Leave Hourly   H      NO   Y 
WCSHR   Workers Comp - Shared Leave   H   WCH   CTKN   Y 
WCSS   Sick Leave Salaried   H   SKL   NO   N 
WCWOP   Worker's Comp - Without Pay   H   WCO   NO   N 
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Defining Workgroups  
In PeopleSoft Time and Labor, employees that share similar characteristics can be grouped together in 
Workgroups.  For the State of Oklahoma it was determined to group full-time, salaried employees from 
the same agency into their own workgroup.  If an agency has hourly/temporary employees they have also 
been grouped together in their own Workgroup. 
 
The naming convention for Workgroups is an eight character value as follows: 

� The first three characters are the agency number. 
� The next three characters are “00-“ 
� The last two characters are either “01” for full-time salaried employees, or “02” for part-

time/temporary employees. 
 
Therefore, Rehabilitation Services will have two Workgroups: 
 

� 80500-01 for their Full-time Salaried Employees and 
� 80500-02 for their part-time/temporary employees. 

 
Let’s take a look at how a Workgroup is defined and see how it relates to the State of Oklahoma. 
Define Business Rules > Define Time and Labor > Setup 1 > Workgroup 
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At the top there is the usual Effective Date, Active and Description fields.  There is also a check mark for 
“Needs Approval”.  It has been determined that all time entered into Time and Labor will have already 
gone through an approval process.  Therefore, this feature will not be used and no Workgroups should 
have this checkbox selected. 
 
Time Type – All Workgroups will have the Time Type designated as Positive Time Reporting. 
 
Compensation Controls – One rule has been established regarding Compensatory Time being 
calculated at time and a half.  The Rule Program ID field will have a value of CORE for each Salary 
related Workgroup.  Each Workgroup will have a TRC Program associated with it (see previous section 
on TRC Program) and should be entered in the TRC Program ID field. 
 
Workgroup Defaults – The Holiday Schedule is maintained in Payroll, but Time and Labor will use it.  A 
Holiday Schedule of PDHOL has been established for Workgroups that include full-time salaried 
employees.  A Holiday Schedule of NONE has been established for Workgroups with part-time, temporary 
employees.  The Time Period ID is not necessary because schedules are not being used at this point and 
we have Positive Time Reporters.   
 
For the sections shown in this screen print, Rounding Options and Day Break Options are not relevant to 
the State of Oklahoma.  These are for Punch-Time Reporters and the State of Oklahoma does not use 
Punch-Time Reporting. 
 
 



 

COR106 Time and Labor Manual Page 23 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

Defining Static Groups 
 

PeopleSoft Time & Labor allows you to set up groups of employees to be used in a variety of on-line and 
batch functions which are called Static Groups.  This is different from Workgroups.  
 

Static Groups are used predominately for batch processing of time and to determine which employees can 
be viewed when entering time.  For example, the Time Administrator for OPM will not be able to enter time 
for employees of Rehab Services.  We will see this in the section regarding processing time. 
 

All the Static Groups for the State of Oklahoma have been established prior to an agency moving into a 
production environment.  You will only have to maintain it as employees come and go from your agency. 
 

In the screen print below, you can see how a Static Group for OPM was established. 
 

 
 

In common terms, what the Select Parameters section is saying is:  “look at the record TL_EMPL_DATA  
(which is where the Time Reporter Page Data is stored) and the field within that record called 
WORKGROUP.  If the WORKGROUP value in the employee’s time reporter page is 54800-01, then add 
that employee to this Static Group”.  The second line says to only include the Time Reporters that are 
Active in this Static Group. So – these two lines are saying if the time reporter has a workgroup = 54800-
01 and the status is Active, add that time reporter to the Static Group. 
 

If the time reporter is not a member of a static group, you cannot see the employee in the drop down list 
to enter time into weekly elapsed time for that employee. 
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ENROLLING & MAINTAINING TIME 
REPORTER 
BUSINESS PROCESS FLOW 
 
 

 

Define Business Rules > Define Time 

& Labor > Enroll > Create Time 

Reporter Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Define Business Rules > Define Time 

& Labor > Enroll > Comp Plan 

Enrollment 

 

 

 

 

Define Business Rules > Define Time 

& Labor > Enroll > Static Group 

 

 

Enroll  

Time 

Reporter 

An employee must be hired in HRMS 

before they can be enrolled in Time & 

Labor.  The Enrollment process may 

be done through a link in HR or directly 

in Time & Labor. 

 

All Time Reporters are Elapsed Time 

Reporters. 

 

 

All Time Reporters will use the Time 

Reporting Template called REGULAR. 

 

All Time Reporters will have a default 

Time Period of PSMONTH or 

BIWEEKLY 

 

No Time Reporters will track tasks.  

Therefore, all Time Reporters will use 

the delivered Taskgroup of 

PSNONTASK. 

 

Employee may be enrolled in multiple 

Comp Plans. 

 

 

 

 

 

New employee gets enrolled in a Static 

Group when group is refreshed. 

Determine Agency 

(workgroup) 

Determine Time 

Reporting 

Template 

Determine Comp 

Plans to Enroll in 

Enroll Time 

Reporter in Comp 

Plans 

Determine Static 

Group to Enroll in 

Refresh Static 

Group to include 

Time Reporter 

Complete 

Time Reporter 
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DEFINING TIME REPORTER DATA 
Enrolling an employee in Time and Labor can be done through the Employment Information page in the 
Job Data component.  Use this approach if you want to enroll them while hiring them or if they are 
changing other job data that will change their Time & Labor enrollment information.  For example, if they 
change agencies they will be changing Workgroups. 
 
The State of Oklahoma has determined that this page will be maintained by HR. 
 
Administer Workforce > Administer Workforce (GBL) > Use > Job Data > Employment Data Link > 
 

 
 
Click the Time Reporter Data link to access the page.
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Use this page if you want to enroll an employee in Time & Labor at HIRE time, REHIRE time or moving an 
employee from one agency to another or one workgroup to another.   
 

 
 

Populate the relevant fields in the following manner: 
 
Payable Time Start Date – leave blank 

Effective Date – WATCH THIS DATE.  On a new HIRE or REHIRE, this date must match the 
HIRE date or the REHIRE date.  On other changes, it should be the date that the change 
becomes effective.  It is the date you want to start entering time for.   

Time Reporter Status – Active 

Send Time to Payroll – Checked – updated by the system when you get out of the record. 
Time Reporter Type – Elapsed 
Time Reporting Template – REGULAR 
Workgroup – Agency Number + 00 + -01 for Salary or -02 for Hourly.  Example: 54800-01 

Taskgroup – PSNONTASK 
Time Zone – CST 
 

Click  at the bottom of the screen. 
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UPDATING STATIC GROUP 
 

Updating the Static Group is the last step in this business process.  This will add or remove Time 

Reporters from the group as necessary.  Static Groups will already be established.  Just navigate to the 

correct Static Group and click  at the bottom of the screen. 

 
Define Business Rules > Define Time and Labor > Enroll > Static Group > Selection Criteria 
 

 
 
A message box will appear indicating how many people were added to the group.  To see the members of 
this group, click on the second tab – Current Group Members. 
 

Always click the  button after adding the employees to the static group. 
 



 

COR106 Time and Labor Manual Page 28 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

CURRENT GROUP MEMBERS 
 

 
 
 
Use FIND to search for the new employees added to the group. 
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ENROLL TIME REPORTER IN COMPENSATORY TIME PLAN 
The next step is to enroll the Time Reporter in the Compensatory Time Plans they are eligible for.  During 
the conversion process, employees were enrolled in plans if they currently had a balance in any of the 
plans.  For example, 100078, Employee was enrolled in two different plans. 
 
NOTE:  Add all Comp Plans before saving. 
 
If you wanted to enroll 100078, Employee in additional plans, you would retrieve his enrollment record as 

in the previous screen then click the  icon on the Effective Date level.  This will provide a new field for 
entering a Compensatory Time Plan.  The other plans are not brought forward and displayed here but the 
employee is still enrolled in them. 
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Enter the 3 new Compensatory Time Plans in the fields provided and click . 
 

 
 
 
NOTE: Always SAVE before you leave the page.

Every time Shared Leave is 
added, there must be a 
Shared Leave Non Term or 
Shared Leave Terminal 
enrollment to track lifetime 
usage. 
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MAINTAIN TIME REPORTER DATA 
BUSINESS PROCESS 
 

 
 
 

 

 

Define Business Rules > Define Time 

& Labor > Enroll > Maintain Time 

Reporter Data 

Maintain 

TR 

Insert new 

row with 

information. 

 

Maintain Time Reporter can be used 

anytime the Time Reporter Page 

needs to be updated. 

 

Most all changes to the page requires 

that a new row be inserted before the 

data can be entered. 

 Most of the time, this will only be a 

workgroup change. 

 

Enroll the Time Reporter in the Static 

Group that the Time Reporter now 

belongs to. 

 

Complete 

Refresh Static 

 Group 
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MAINTAIN TIME REPORTER DATA PAGE 
 
Notice that the Maintain Time Reporter Data page looks exactly like the Create Time Reporter page. 
 

 
 
 
Make changes as necessary. Insert a new effective dated row when you have to make changes. 
For example, if a person switches Workgroups, insert a new row with the date it becomes effective and 
enter the other appropriate values. 
 
Always SAVE before you leave the page. 
 

NOTE: The HIRE and Adding a Concurrent Job selection will automatically insert this page for you.  Any 
other type of action requires you to manually insert a row to make your changes. 

 

NOTE: Remember to update the Static Groups if someone switches Workgroups or Agencies. 
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Self Service > Manager > Tasks > 

Weekly Elapsed Time 

Collect 

Time 

Info 

Identify Time 

Reporters to enter 

daily time for. 

Enter hours and 

TRC by Time 

Reporter. 

Time info 

collected 

 

 

 

 

 

 

A Time Reporter is any employee 

having time entered in Time & Labor. 

 

 

 

Enter all time and Time Reporting 

Codes for Hourly/Temps and only 

exceptions for Salaried employees. 

ENTERING TIME 
BUSINESS PROCESS FLOW 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

All time that is entered or loaded at the State of Oklahoma will be entered through the Weekly  
Elapsed Time Page. 
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WEEKLY ELAPSED TIME 
 
Self Service > Manager > Tasks > Weekly Elapsed Time 
To enter time for an employee, navigate to the Weekly Elapsed Time page.  At the Search Dialog Box, 
enter the Employee ID and Date.  You can click on the magnifying glass  next to the Emplid field to 
search by name.  You can also click on the calendar icon to display the calendar and select a date from 
there. 
 

NOTE:  The date entered in the date field will be the first day displayed on the Weekly Elapsed Time 
page.  For example, 1/03/06 is a Tuesday.  Therefore, the days displayed on the Weekly Elapsed Time 
page will start with Tuesday and end with Monday.  If 1/01/06 were entered, then the days would display 
Sunday thru Saturday. 

 

 

Enter the 

Employee ID 

Click on this icon 

to display this 

calendar. 
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For this example, our employee is a full time, salaried employee, so we will only enter their exceptions for 
this pay period.  We will enter 8 hours of Leave without Pay, Scheduled (TRC=LWOPS) on January 4 and 
$525.00 of Longevity also on the 4th and 8 hours of Comp Time Earned (TRC=CTE) on January 5th. 
 
The TRC (Time Reporting Code) drives the input for the week that is being entered.  Each Type of TRC 

must have its own row.  Use  button to add a row. 
 

WEEKLY ELAPSED TIME PAGE 
 
Enter 8 hours Leave without Pay, Scheduled (LWOPS) on January 4th 
 

 
 

Click . 
 
Enter Longevity for $525.00 also on January 4th. 
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Click . 
 
Key in the Comp Time Earned of 8 hours on January 5th. 
 

 
 

Click. . 
 

When I clicked on SAVE, I received this message: 
 

 
 
It tells me that I haven’t setup the Comp Time Plan for my employee and I cannot save the time I 
entered for TRC CTE. 
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I have two choices:  I can delete the CTE time and forget it or I can go back and enroll my 
employee in the Comp Time Plan.  I have to delete the CTE row to save my other two rows. 
 
To enroll the employee in the comp time plan, go to  
 
Define Business Rules > Define Time and Labor > Enroll > Comp Plan Enrollment 
Select the plan and save. 
 
Go back to Weekly Elapsed Time and add the additional row for CTE. 
Self Service > Manager > Tasks > Weekly Elapsed Time 
 
 
You must SAVE on this page before you go to another week.  The system will let you change 
pages without the data being saved. 
 
After you save, the page looks like this one.  It sorts the rows based on Time Reporting Code 
values. 
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Click  and enter 8 hours of Annual Leave on January 11th and click  
to save the Record. 
 

 
 
 
In production, you will continue this process, entering time for all employees in your Workgroup.  You will 
want to enter time on a daily or weekly basis.  You can change data as needed because nothing really 
happens until you perform the next step – Running Time Administration.  You can even change data after 
that. 
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Administer Workforce > Capture 

Time & Labor > Process > Time 

Administration 
Process 

Time 

Info 

Identify Time 

Reporters or Static 

Groups to process  

Determine the 

correct processing 

date 

Time 

Processed 

 

Employee must be hired in HRMS 

enrolled in a workgroup and enrolled in 

a static group before time can be 

entered 

 

 

 

Time Reporter is any employee who 

has their time processed through the 

Time & Labor system. 

 

Static Groups (not workgroups) are a 

group of Time Reporters that can be 

brought together under one group 

usually for processing. 

 

The processing date will usually be the 

last day of the pay cycle. 

 

 

 

 

 

See also: Review Payable Time and 

Review Exceptions 

 

Process Time 

PROCESSING TIME 
BUSINESS PROCESS FLOW 
 
 
            -
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RUNNING TIME ADMINISTRATION (TIME ADMIN) 
Now that time has been entered, it needs to be processed.  This is done by running a batch job called 
Time Administration.  Let’s take a look at the page and see how it works. 
 

When using this page, leave the checkboxes as is.  The Process Date and the Employee(s) or Group(s) 
to process are the important fields.  
 

Notice the  and  buttons.  These work the same way as all other pages in PeopleSoft.  This allows 
you to enter one or more employees and/or groups.  If you enter a value in the EmplID field then tab out, 
the Group ID field disappears.  Likewise, if you enter a value in the Group ID field and tab out, the EmplID 
field disappears. 
 

The Process Date will process all time up to and including that date.  You will generally want this to be the 
last day of your pay period. 
 

After completing the run control fields, click .  It is not necessary to save this page since when 

you click the  button the record will be saved. 
 

Administer Workforce > Capture Time and Labor > Process > Time Administration > Run Control 
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After clicking the  button, another page is displayed.  You can leave the defaults. 
 

To begin the batch process, click . 
 
Administer Workforce > Capture Time and Labor > Process > Time Administration > 
Process Scheduler Request 

 
 
All processes will run on PSUNX with the exception of Crystal Reports – which run 
on PSNT. 
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After clicking  , you are taken back to the Time Administration Run Control page.  Click the 
Process Monitor link to see the progress of the job. 
 

 
 
 
The process instance number assigned is very important.  If you experience a problem with the 
process running or dying on Process Monitor and need help from the Help Desk.   The Help 
Desk will request the Process Instance Number to aid in research. 

Click the Process Monitor 

hyperlink to watch the 

process run. 

Process has been submitted 

when a Process Instance 

Number is assigned. 
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The Process Monitor will show all jobs based on the criteria you have entered at the top of the page (your 
User Id, Last number of Days, etc…). 
 
The job will have a different status as it progresses.  When completed, it will indicate a status of ‘Success’.  

Click  occasionally to get an update on the status.  You will get used to how long certain jobs 

take to run.  As you might expect, the time it takes to process Time Administration is heavily dependent on 

the number of employees being processed. 

 

 
 
 
When the process goes to ‘Success’ – click the Details link to go to the next page. 
 
Select View Log/Trace blue hyperlink to get to the Message Log.

Click the Refresh 

Button to watch 

the progress of 

the process. 

Run Status must say 

‘Success’ before you can 

see the output of the 

process. 
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Message Log Output of Time Administration Process 
 
PeopleTools 8.19.09 - Application Engine 
Copyright (c) 1988-2006 PeopleSoft, Inc. 
All Rights Reserved 
 
 
2006-01-05-09.24.36.000000 -- Starting TL_TIMEADMIN (13507,13) 
 
2006-01-05-09.24.40.000000 -- Starting TL_TA000200 (13507,13) 
 
2006-01-05-09.24.41.000000 -- Starting TL_TA000300 (13507,13) 
 
2006-01-05-09.24.43.000000 -- Starting TL_TA000400 (13507,13) 
 
2006-01-05-09.24.43.000000 -- Starting TL_TA000410 (13507,13) 
 
2006-01-05-09.24.43.000000 -- Starting TL_TA000420 (13507,13) 
 
2006-01-05-09.24.44.000000 -- Starting TL_TA000500 (13507,13) 
 
2006-01-05-09.24.45.000000 -- Starting TL_SCHRES_AE (13507,13) 
 
2006-01-05-09.24.46.000000 -- Starting TL_TA000700 (13507,13) 
09.24.47 UpdateStats ignored - COMMIT required\n 
 
2006-01-05-09.24.48.000000 -- Starting TL_TA000800 (13507,13) 
 
2006-01-05-09.24.48.000000 -- Starting TL_TA000900 (13507,13) 
 
2006-01-05-09.24.53.000000 -- Starting TL_TA001000 (13507,13) 
 
2006-01-05-09.24.54.000000 -- Starting TL_TA001100 (13507,13) 
 
2006-01-05-09.24.54.000000 -- Starting TL_TA001200 (13507,13) 
 
2006-01-05-09.24.54.000000 -- Starting TL_TA001300 (13507,13) 
 
========>                  100% of the job completed. (13507,981) 
Application Engine program TL_TIMEADMIN ended normally 
3507,981) 
Application Engine program TL_TIMEADMIN ended normally 

 
If you get the message on the 3rd line from the bottom -  ‘No Employees Available for 
Processing’, this means you did not process any Weekly Elapsed Time for anyone. 
 
After checking the Message Log, we have to go to check for ‘payable time’ for the time that was 
entered in Weekly Elapsed Time.

This line should 
be blank if the 
employee was 
processed 
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Inquire 

Payable 

Time 

 

 

 

 

 

 

 

 

 

 

 

 

Self Service > Manager > View > 

Payable Time Summary 

 

Self Service > Manager > View > 

Payable Time Detail 

 

    Payable Time    

Reviewed 

Summary or 

Detail info by 

TR 

Summary Detail 

 

 

Payable Time is updated during Time 

Admin run.  If time passes all edits, it 

becomes Payable Time and can be 

loaded to Payroll. 

 

 

 

 

Time Reporter is any employee who 

has their time processed through the 

Time & Labor system. 

 

 

 

 

 

There is also a Payable Time Report 

that can be run TL001.  Refer to 

PeopleBooks for sample report. 

 

 

VIEW PAYABLE TIME 
BUSINESS PROCESS FLOW 
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VIEWING PAYABLE TIME 
 
Once the job is complete, Payable Time can be viewed. 
 
To see the Payable Time we navigate to the Payable Time Detail page.  You must enter both the Empl Id 
and a Start Date.  Note:  Another shortcut in PeopleSoft is that you do not have to enter dashes or slashes 
when entering dates.  For example, May 1, 2004 can be entered as 050104 rather than 05/01/2004. 
 
Both the Employee ID and Start Date (the date that the time was posted for), must be entered or you will 
receive an error.  Enter a date of January 4, 2006 to see our time for Longevity, Leave without pay, 
scheduled and Comp Time Earned.  . 
 
Self Service > Manager > View > Payable Time Detail 
 

 
 
Click   to go to the next page. 
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The Payable Time Detail page shows the time per week. 
 

 
 
 
This page shows the data that was entered on the Weekly Elapsed Time page and processed through 
Time Administration.  The only field that is new to us is the Payable Status field.  When Time 
Administration has processed the data, the Payable Status should be Estimated – Ready for Payroll.  
Once Payroll takes the data and starts processing it the status will change. 
 
We see the results for the Comp Time we entered also.  Notice that the Payable Status indicates Needs 
Approval.  The reason this does not show a Payable Status of Estimated – Ready for Payroll is because 
employees do not get paid when they earn Comp Time.  They get paid when they take Comp Time.  While 
this row will remain in this status indefinitely, the employee’s Comp Time balance will be updated to reflect 
the eight hours earned.   
 
Navigation:  Home > Administer Workforce > Capture Time and Labor > Manage > 
Approve Time by Group 
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PAYABLE TIME STATUSES 
The following table is from PeopleBooks and discusses the relevant statuses that will be encountered at 
the State of Oklahoma.  This is a good time to talk about the different status that Payable Time can have. 
 

 
Status 

 
Description 

ES – Estimated, Ready for 
Payroll 

This is the first stage of payable time created by the Time Administration process, 
unless you've activated the Needs Approval option on the Workgroup page. It 
includes cost estimates calculated by Time Administration if you've selected the 
Calculate Estimated Gross option on TL Installation Page. 

Time Administration updates the original payable time whenever you change 
reported time that relates to payable time with a payable status of Estimated-Ready 
for Payroll.  

NA - Needs Approval  This stage is like estimated payable time except that the time must be approved 
before it can be sent to a payroll system. You approve time using the Approve 
Payable Time page.  

Time Administration updates the original payable time whenever you change 
reported time that relates to payable time with a payable status of Needs Approval. 

AP – Approved, Goes to 
Payroll 

Approved payable time can be sent to your payroll system. When payable time 
reaches the approved stage, the system sets the frozen indicator on.  

Time Administration creates offsetting entries whenever you change reported time 
that relates to payable time with a payable status of Approved-Goes to Payroll..  

CL - Closed  Payable status is set to closed when any of the following conditions are met. (When 
payable time reaches the closed stage, the system turns on the frozen indicator.) 

• The Send to Payroll option is not activated for the time reporter (on the 
Create Time Reporter page). 

• The Send to Payroll option is not activated for the time reporting code (on 
the TRC Setup page). 

• The payable time represents a record adjustment made through the 
Adjust Paid Time page. 

• The payable time has been taken by Payroll, but it will not be labor 
distributed or diluted because you did not select the Labor Distribution and 
Dilution options on the Pay System page. (In this case, you'll see the Pay 
System code and Pay Request Number on the View Payable Time Details 
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page.) 

Time Administration creates offsetting entries whenever you change 
reported time that relates to payable time with a payable status of Closed. 

SP - Sent to Payroll Payable time is in a Sent to Payroll stage from the moment it's sent to Payroll to the 
time Payroll either takes or rejects the entry. When payable time reaches the Sent 
to Payroll stage, the system turns on the frozen indicator. 

Time Administration creates offsetting entries whenever you change reported time 
that relates to payable time with a payable status of Sent to Payroll. 

RP - Rejected by Payroll Time that Payroll has refused.  

Time Administration creates offsetting entries whenever you change reported time 
that relates to payable time with a payable status of Rejected by Payroll. 

TP – Taken, Used by Payroll  Time has been accepted by Payroll. Time Administration creates offsetting entries 
whenever you change reported time that relates to payable time with a payable 
status of Taken — Used by Payroll. 

 
 
As a rule. The State of Oklahoma will not be approving time.  Time is considered approved before it is 
entered into PeopleSoft.  However, there are a couple of exceptions to this rule. Time Reporting Codes 
that are not mapped to a Payroll Earn Code remain in a status of “Needs Approval”.  For example Comp 
Time Earned (CTE) is not mapped to an Earnings Code.  The reason is because employees do not get 
paid for earning Compensatory Time.  They get paid when they take the time.  The Time Reporting Code 
used when taking Comp Time is mapped to a Payroll Earnings Code. 
 
Annual Leave and Sick Leave entries that are adding time back to the employee’s respective balances, 
must be approved.  These entries will have a minus in front of the hours on Payable Time. 
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REVIEWING EXCEPTIONS 
 BUSINESS PROCESS FLOW 
 
 
 

 

Review 

Exceptions 

Time info 

collected 

 

 

 

 

 

 

 

TR = Time Reporter, a person 

who has their time processed 

through the Time & Labor 

system. 

 

 

 

 

 

If exceptions were resolved,  

Time Admin will need to be run 

again. 

 

Decide if 

reviewing by 

group or TR. 

Resolve 

Exceptions 

for TR 

 

 

 

 

 

 

 

 

 

 

Administer Workforce, Capture Time 

and Labor, Manage, Manage 

Exceptions 

 

Administer Workforce, Capture Time 

and Labor, Manage, Manage Group 

Exceptions 

 

 

 

 

 

 

 

Administer Workforce > Capture 

Time & Labor > Process > Time 

Administration 

 

Resolve 

Exceptions 

by group 

Were 

exceptions 

corrected? 

Run Time 

Admin 

Yes 

No 
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CHECKING FOR EXCEPTIONS 
 
Occasionally, the Time Administration process will generate exceptions to prevent data from being 
processed incorrectly.   An exception will be generated indicating why the time could not be processed.  
 
Once Time Administration is complete we would normally check the Payable Time page to ensure the 
time was processed.  Since this employee has 2 job records, we will check both of them 
 
Self Service > Manager > View > Payable Time Detail 
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We check Record 0 and it shows us this page. 
 

 
 
No payable time shows on this page. 
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We go back and check Record #1 and it shows the following page. 
 

 
 
No payable time has been generated for Record #1 but it has flagged some time entered for Record 
#1 as having Exceptions with the Pending Exceptions bar.  Click on the bar and it will take you directly 
to the flagged exceptions. 
 
Sometimes this message will be displayed.  If you know that you really entered the correct 
Employee ID and the EXACT date you entered the time for in Weekly Elapsed Time, then 
you must check from exceptions because Payable Time was not generated. 

 

No payable time because 

Time Admin has 
generated exceptions 
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We can check for exceptions by group or employee to see if there are any exceptions.  In our 
example, we’ll look by group. 
 

Enter Static Group Number and just click  once we navigate to the Manage Exceptions 
page. 
 

MANAGE GROUP EXCEPTIONS 
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EXCEPTIONS DETAIL INFO 
 

 
 
Click the blue hyperlink in the More Column to receive an explanation for that specific 
exception.  We will look at TLX00010 – Invalid Leave Time Taken. 
 
On the Date field, the first item in weekly lapse time that created the exception.  No other 
time will process until this error has been cleared. 
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Exception TLX00010 – for employee 100193 is shown below. 
 

 
 

Only the first two possible reasons are visible in the box.  Use the scroll arrows on the right 
hand of the box to see the other possible reasons for the error condition.  All 6 of them are 
listed below. 
 

1. Check Time Reporter's Leave Time balance 
2. Check Time Reporter's Leave Plan 
3. Leave TRC may be mapped to a NA Earnings Code that is not mapped to a Leave Plan Type 
4. Time Reporter may not have a Leave Plan 
5. A Negative Balance may not be allowed on the Leave Plan 
6. Leave Time may exceed Max Negative Hours allowed on Leave Plan 



 

COR106 Time and Labor Manual Page 57 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

 
We are looking at the exception TLX00030 – for this same employee 
 

 
 
The exception message tells us that the Time Reporter Status is Inactive and Time Admin cannot 
process time for an Inactive Reporter. 
 
There are two (2) choices. 
 

Choice 1 – We entered the time in error and shouldn’t have.  In this case, we go back to Weekly 
Elapsed Time and delete the time for this employee on the specific days.  Save the 
Page and run Time Admin again to correct the exception. 

 
Choice 2 – We have to pay this employee for this time so that means we have to go to the Time 

Reporter Page to review the problem. 
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Since this employee has 2 JOB Records, the employee will also have 2 Time Reporter Pages – one 
for each of the JOB Records. 
 

Time Reporter Page – Employee Record #0 – shows the status to be Active. 
 

 
 

Time Reporter Page – Record #1 – shows the status to be INACTIVE. 
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When we look at the Manage Group Exceptions Page again for Employee 100193 – we see that the 
time that is flagged with an exception is for Record #1 – the record that has an INACTIVE status. 
 
 

 
 
 
So – the question is – 1. Did we enter the Weekly Elapsed Time for the wrong Employee Record #1? 

2. Did someone help us and inactivate the Employee Record #1 too soon? 
 
Solution for Option #1. 
If we entered the Weekly Elapsed Time for the wrong Employee Record – it was determined that the 
time should have been entered for Employee Record 0 – 

To correct this situation – we go back to Weekly Elapsed Time. 
 
Self Service > Manager > Tasks > Weekly Elapsed Time > Employee 100193 – Record #1 
 

Delete the rows that have the time on it for this employee and click . 
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Click  and select Record #0 for this employee and enter the time on the 
correct days for employee number 100193 and SAVE the record.  Run Time Admin again and it 
should clear up the exception on Record #1 and generate Payable Time for Record #0. 

 
Solution for Option #2. 
 

If the Time Reporter Page was inactivated before we finished paying this person, the status must 
be changed back to Active to allow Time Admin to process the time entered against this 
Employee Record #1. 
 
The only way to change the status back to Active for this record is by using Correct History and 
you do not have the security that will allow you to make the change. 
 
Call the Help Desk and file a case with them explaining the problem and they will send it to the 
CORE Payroll Team who will make the correction for you and let you know when it is done so 
that you can continue your payroll.    
 
Please give the Process Instance – if applicable  - when filing a Help Desk Case. 
 
After the CORE Team calls you, the next step is running Time Admin again which will clear up 
the Exceptions and generate payable time for those rows. 
 
Payable Time will then be pulled into Payroll to get the employee paid. 

 
Once Time Administration is complete we would normally check the Payable Time page to ensure the 
time was processed successfully.  If we have Payable Time, we don’t have to check the Manage 
Exceptions Page again. 
 
 



 

COR106 Time and Labor Manual Page 61 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

CORRECTING TIME 
BUSINESS PROCESS FLOW  

 
 

 

 

 

 

 

 

Self Service > Manager > Tasks > 

Weekly Elapsed Time 

 

 

 

 

 

 

 

 

 

Administer Workforce > Capture 

Time & Labor > Process > Time 

Administration 

 

Correct 

Time 

Identify Time 

Reporters to correct  

time for. 

Change/Add hours 

and TRC by Time 

Reporter. 

Time info 

corrected 

 

 

 

 

 

 

This may be from View Payable Time 

page, Payable Status Report or notice 

from Payroll that change needs to be 

made. 

 

 

Use Weekly Elapsed Time page to 

retrieve original information to be 

added to or modified and make 

changes as needed. 

 

 

Changes will be reflected in the next 

Pay Run.  If the current Pay Run has 

not been confirmed yet, these changes 

can still be included in that run. 

Run Time Admin 
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As mentioned, earlier time can be corrected before Payroll starts processing it.  In fact, time can be 
changed up until Payroll runs the Confirm process.  So let’s assume that we recorded the Comp Time 
Earned for Employee 100078 incorrectly.  It should have been 4 hours of Comp Time Earned instead of 8 
hours. 
 
Bring up the Weekly Elapsed Time page again and make the correction by over keying the  
Original 8 hours with the correct value of 4 hours.   
 

WEEKLY ELAPSED TIME 
 
Self Service > Manager > Tasks > Weekly Elapsed Time 
 

 
 

Click . 
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TIME ADMINISTRATION PROCESS 
 
Next, we need to run Time Administration again to process the time.  Ensure that the process date is the 

last day of your pay period.  Click . 
 
Administer Workforce > Capture Time and Labor > Process > Time Administration – run control 
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PAYABLE TIME DETAIL 
 
After getting a Run Status of ‘Success’, we will take a look at the Payable Time and see that our hours 
now indicate 4. 
 
Self Service > Manager > View > Payable Time Details 
 

 
 
Look at Compensatory Time Balance page to see the change note the balance. 
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Review 

Comp  

Time 

 

Self Service > Manager > View > 

Compensatory Time Balance 

 

OR 

 

Administer Workforce, Capture Time 

and Labor, Inquire, Review 

Compensatory Time 

Determine Time Reporter 

and Comp Plan to inquire 

balance on. 

 Comp Time 

Reviewed 

 

 

 

Comp Time is updated when Time 

Admin is run. 

 

 

 

 

 

Select from list of Compensatory Time 

Plans if Time Reporter is enrolled in 

more than one plan. 

VIEW COMPENSATORY TIME BALANCE 
BUSINESS PROCESS FLOW 
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CHECKING A COMPENSATORY TIME BALANCE 
 
You can view an employee’s Compensatory Time Plan balance using an online inquiry page.  Navigate to 
the Compensatory Time Balance page and enter the EmplID.  You can also enter a Comp Plan or click 

 and select from the list if they are enrolled in more than one plan. 
 

 
 
The following Compensatory Time Reports are very helpful. 
 

GO_TL_COMP_DAY_BAL 
GO_COMPLEAV_TBL_BY_EMPLID 
 

Click Comp Plan 

to review. 
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Currently, the page shows no hours.  You might expect the Balance at the Beginning of Today to be equal 
to 8 and the number of hours expiring within a certain period to also be 8.  Remember, that we entered the 
8 hours of Comp Time Earned on May 19th.  As you can see from the screen print, the current date is May 
13th.  Therefore, it indicates that as of May 13th the employee has not earned this Comp Time yet. 
 

NOTE: The ‘Show Time Expiring In’ field is currently set to 30 days.  The COMPREG Comp Time Plan is 
setup so if time is not taken it will expire in 180 days.  Therefore, there is no time expiring in the next 30 
days.  Choose “Show All” in the Show Time Expiring Field. 

 
Self Service > Manager > View Compensatory Time Balance 
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PROCESSING COMP TIME 
 

OVERVIEW 
 
All the comp time entries – comp time earned, comp time taken, comp time shared, comp time given and 
comp time received are entered into the Weekly Elapsed Time Page in Time and Labor.  These entries 
are processed by Time Administration and the information and balances remain in Time and Labor.  
 
The State of Oklahoma has designed and uses a Leave Statement.  This Leave Statement pulls the comp 
time information from Time and Labor and prints it along with the other kinds of leave that employee has 
available. 
 
The following is a list of the predefined Comp Time Off Plans for the State of Oklahoma. 
 

Comp Time Off Plans 
 
COMPCORE   Comp Core Project 
COMPPUB   Comp Time Plan – Public Safety 
COMPREG   Comp Time – Regular 
COOLOFF   Admin Leave – Cool Off (32 hours) 
ENFORCED   Enforced Leave Plan – (80 hours) 
HOLIDAY   Holiday Leave Plan 
MILITARY   Military Leave – (240 hours) 
ORG    Organizational Leave – (24 hours) 
SHARED   Shared Leave 
SHLFNOTERM (accumulator)    Shared Life Non Term – (2088 hours which is 261 days) 
SHLFTERM (accumulator)         Shared Life Term – (2920 hours which is 365 days) 
 
When using Shared Leave, you must also post the time taken to either SHLFNOTERM or 
SHLFTERM.  These two are used to accumulate the total hours that have been taken. 

 
 
The employee must be hired (usually done by HR) and enrolled in a Static Group (usually done by 
payroll) and in whatever comp time plans (usually done by payroll) for which they are eligible before any 
type of comp time (earned or taken) can be entered into Time and Labor – Weekly Elapsed Time for that 
employee. 
 
The employee must also have a Comp Time Balance for the specific plan with a date prior to the date you 
want to enter Comp Time Taken into Time and Labor - Weekly Elapsed Time. 
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COMP TIME PLANS AND THEIR TRCS 
 
In the section of this manual entitled “Enrolling Time Reporters”, we enrolled employee 100078 
into Static Group 54801. 
 
We also enrolled this employee into Comp Time Off Plans of Enforced, Org, CompReg, 
Shared, and Shlfnoterm.  The following is a list of the Comp Time Off Plans and the TRCS 
that affect them. 
 
Time Reporting Codes for the COMPREG Comp Time Plan 

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

CTE   Comp Time Earned   H       CERN   Y 

CTEAD   Comp Time Earn Adjustment   H       CERN   Y 
CTEH   Comp Time - Time and a Half   H       CERN   Y 
CTPO   Comp Time Payout   H   CTO   CTKN   Y 
CTT   Comp-Time Taken   H   CTP   CTKN   Y 
DCTFY   Deceased Comp Time Follow Yr   H   TCP   CTKN   N 
DTHCP   Deceased Comp Time   H   DCP   CTKN   Y 
FLCT   FMLA Charged to Comp Time   H   FMC   CTKN   Y 

 
Time Reporting Codes for the COMCORE Comp Time Plan     
The TRCs are the same as the COMPREG plan but end with a 1. 
 
Time Reporting Codes for the COMPREG Comp Time Plan     
The TRCs are the same as the COMPREG plan but end with a 2. 
 
Time Reporting Codes for the COOLOFF Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

ADLAD   Admin Lv Cool Off Adjustment   H       CERN   Y 

ADLCO   Salary Admin Cool Off   H   ADL   CERN   Y 
COCNV   Cooloff for Conversion   H       CERN   Y 
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Time Reporting Codes for the ENFORCED Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

ENCNV   Enforced for Conversion   H       CERN   Y 

ENFAD   Enforced Leave Adjustment   H       CERN   Y 
ENFLV   Enforced Leave   H   ENF   CERN   N 

Time Reporting Codes for the HOLIDAY Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

DHLFY   Deceased Holiday Pay Follow Yr   H   THL   CTKN   N 

DTHHL   Deceased Holiday Pay   H   DHL   CTKN   Y 
FMHL   FMLA Charged Holiday Pay   H   FMH   CTKN   Y 
HLCNV   Holiday for Conversion   H       CERN   Y 
HOLAD   Holiday Leave Adjustment   H       CERN   Y 
HOLPO   Holiday Payout   H   HPD   CTKN   Y 
HOLT   Holiday - Salary   H   HOL   CTKN   Y 
HOLWK   Holiday Worked   H       CERN   N 

 
 
Time Reporting Codes for the MILITARY Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

MILAD   Military Leave Adjustment   H       CERN   Y 

MILLV   Military Leave Salary   H   MLS   CERN   Y 
MLCNV   Military for Conversion   H       CERN   Y 

 
 
Time Reporting Codes for the ORG Comp Time Plan 

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

OGCNV   Org Leave for Conversion   H       CERN   Y 

ORGAD   Organizational Leave Adjustment   H       CERN   Y 
ORGLV   Organizational Leave Salary   H   OLS   CERN   Y 

 



 

COR106 Time and Labor Manual Page 71 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

 
Time Reporting Codes for the SHARED Comp Time Plan 

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

FMSH   FMLA Charged Shared Leave   H   FMR   CTKN   Y 
S1CNV   Shared Lv for Conversion   H       CERN   Y 
SHLAD   Shared Leave Adjustment   H       CERN   Y 
SHLGV   Shared Leave Given Back   H       CTKN   Y 
SHLVT   Shared Leave Taken   H   LVS   CTKN   Y 
SHREC   Shared Leave Rec   H       CERN   N 
WCSHR   Workers Comp - Shared Leave   H   WCH   CTKN   Y 

 
Time Reporting Codes for the SHLFNOTRERM Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

S2CNV   Shared Non Term for Conversion   H       CERN   Y 

SHLNA   Shared Leave Non-Term Adjust   H       CERN   Y 
SHLNT   Shared Leave Non-Terminal   H       CERN   Y 

 
Time Reporting Codes for the SHLFTERM Comp Time Plan     

TRC 
  

Descr 
  TRC 

Type 
  Earn 

Code 
  

Comp 
Leave 

Ind 
  

Add 
to 

Gross 

S3CNV   Shared Lv Term for Conversion   H       CERN   Y 
SHLTA   Shared Leave - Term ILL Adjust   H       CERN   Y 
SHLTR   Shared Leave - Terminally Ill   H       CERN   Y 
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WEEKLY ELAPSED TIME ENTRY 
 
Self Service > Manager > Tasks > Weekly Elapsed Time 
 

 
 
PeopleSoft requires a comp time balance before any comp time can be taken. 
 
The Comp Time Earned hours must be entered first via the Weekly Elapsed Time Page  
and processed through Time Administration to record the Comp Time Earned Balance. 
 

Enter the Employee ID 
and the date you want to 
start entering time 
Click on Search 

Click on the Employee ID and it 

will take you to the next page 
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Key the time for October 4th into the Tuesday field. 
Key the time for October 6th into the Thursday field. 
 
Select the Time Reporting Code of CTE from the drop down list. 
 

 
 
Click . 
 

Click  to continue entering time for the next week. 
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Key the time for October 8th into the Saturday field. 
Key the time for October 12h into the Wednesday field. 
Select the  Time Reporting  Code of  CTE from the drop down list. 
 

 
 
 

Click . 
 

Click  to continue entering time for the next week. 
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RUNNING TIME ADMINISTRATION 
 
Administer Workforce > Capture Time and Labor > Process  > Time Administration 
 

 
 
Select an existing Run Control ID or Add a New Value 
 
Complete the Process Time Admin Run Control. 
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It will take you to the next  screen – Process Scheduler Request 
 
 
Process Scheduler Request 
 

 

Enter the Employee ID, 

Change the date to 
10/31/05 and click the 

yellow Run button 

Be sure the Server Name is 
PSUNX 
Click OK to release the 
process to run. 
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A Process Instance Number is assigned when the process is submitted. 
 

 
 

Run the Time Administration Process to Success 
 

 

Process Instance 

Number is assigned. 
Click on the Process 
Monitor hyperlink to 

go to the next page. 

When the process goes to 
Success, click on Details 
to see the output of the 
process. 
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Click on View Log/Trace to 
see output of process 

Click on 
Message Log to 
open it. 
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MESSAGE LOG 
 
PeopleTools 8.19.09 - Application Engine 
Copyright (c) 1988-2006 PeopleSoft, Inc. 
All Rights Reserved 
 
 
2006-01-11-15.41.30.000000 -- Starting TL_TIMEADMIN (13507,13) 
 
2006-01-11-15.41.33.000000 -- Starting TL_TA000200 (13507,13) 
 
2006-01-11-15.41.34.000000 -- Starting TL_TA000300 (13507,13) 
 
2006-01-11-15.41.35.000000 -- Starting TL_TA000400 (13507,13) 
 
2006-01-11-15.41.36.000000 -- Starting TL_TA000410 (13507,13) 
 
2006-01-11-15.41.36.000000 -- Starting TL_TA000420 (13507,13) 
 
2006-01-11-15.41.37.000000 -- Starting TL_TA000500 (13507,13) 
 
2006-01-11-15.41.39.000000 -- Starting TL_SCHRES_AE (13507,13) 
 
2006-01-11-15.41.40.000000 -- Starting TL_TA000700 (13507,13) 
15.41.41 UpdateStats ignored - COMMIT required\n 
 
2006-01-11-15.41.41.000000 -- Starting TL_TA000800 (13507,13) 
 
2006-01-11-15.41.42.000000 -- Starting TL_TA000900 (13507,13) 
 
2006-01-11-15.41.47.000000 -- Starting TL_TA001000 (13507,13) 
 
2006-01-11-15.41.48.000000 -- Starting TL_TA001100 (13507,13) 
 
2006-01-11-15.41.48.000000 -- Starting TL_TA001200 (13507,13) 
 
2006-01-11-15.41.48.000000 -- Starting TL_TA001300 (13507,13) 
 
========>                  100% of the job completed. (13507,981) 
Application Engine program TL_TIMEADMIN ended normally 

           

 
Everything looks good here so we get out of the Message Log and go to check Payable Time. 
 
If you get ‘No employees available for processing’ on the 3rd line from the bottom – that means what 
weekly elapsed time was not processed for anybody in the Time Administration Run.  Nothing happened. 
 
Check the process date on the Time Admin run control.

Be sure that 
this line is 
blank 
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CHECK FOR PAYABLE TIME 
 

Self Service > Manager > View > Payable Time Detail 
 

 
 

There should be one line of payable time for every line of Weekly Elapsed Time entered. 
 

 
 

In the Payable Status field, the example reflects Comp TRC equal “Needs Approval”, however, the 
balance is updated after Time Admin process is completed. 

Enter Employee ID and 
the EXACT date that 
you entered time on in 
Weekly Elapsed Time 
Click Search 

Click the Next 
Week button to 
continue checking 



 

COR106 Time and Labor Manual Page 81 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

 

VIEWING COMPENSATORY TIME BALANCES 
 

Self Service > Manager > View > Compensatory Time Balance 
 

 
 

 
 

Enter Employee ID 
Select COMPREG from the 
list 
Click yellow Search button 

Shows a Balance of 32 
hours because it had a  
Starting balance of 8 hours 
and we posted 24 hours of 
Comp Time 
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Self Service > Manager > Tasks > Weekly Elapsed Time 
 
Post Comp Time Taken for our employee. 
 

 
 
 

 
 

Enter the Employee ID and the 
date we want to start to enter 
the Comp Time Taken. 

Click on Add a New Line 
Enter 5 hours on 10/07 
Select CTT from the TRC drop 
down list 
Click on SAVE 
Click on Next Week 
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The next step is to Run Time Administration again. 

Click on Add a New Line 
Enter 6 hours on 10/17 
Select CTT from the drop 
down list 
SAVE  the page. 
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Run Time Administration with an end of payroll period process date.  This process can be run for an 
individual employee or a group of employees. 
 
Administer Workforce > Capture Time and Labor > Process > Time Administration 
 

 
 
When the process runs to ‘Success’, click Details hyperlink and View Log/Trace to get to the Message 
Log. 
 
Check the Message Log to be sure that we processed the time. 
 
Check for Payable Time. 
 

Process Instance 

# is assigned 
when the process 

is submitted to the 

machine 
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Self Service > Manager > View > Payable Time Detail  
 

 
 

 

Enter Employee ID and the 
EXACT date that we enter 
time for Comp Time Taken 
Click on Search 

CTT for 5 hours 
Estimated  - Ready for 
Payroll 
Click Next Week button 
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Self Service > Manager > View > Compensatory Time Balance  
 

 
 
 

We have CTT of 6 hours on 
10/17/05 which is Estimated 
– Ready for Payroll 

Our Comp Time 
Balance was 32 Hours 
and we took 11 hours 
of Comp Time and our 
balance is 21 hours. 
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PROCESS SHARED LEAVE – GIVING & 
RECEIVING 
 

OVERVIEW 
 

The State of Oklahoma allows the giving of accumulated annual leave and accumulated sick leave from 
one employee to another employee that has a long-term medical emergency that has used all of their own 
accumulated leave.  This giving and receiving is referred to as Shared Leave. 
 
The amount of hours given from one employee to another has to be subtracted from the giving 
employee’s leave balance to reduce it.  It also has to be added to the receiving employee’s leave balance 
before that employee has the time available to be taken.  
 
Two special accumulators have been established that will be updated each time that shared leave time is 
taken.  The special accumulators are SHLFNOTERM – Shared Life Non Term with a maximum limit of 
261 days or 2088 hours and SHLFTERM – Shared Life Term with a maximum limit of 365 days or 2920 
hours. 
 
There are a set of Time Reporting Codes (TRCs) set up to record these transactions. 
 
Annual and Sick Leave TRCS for the GIVING employee  are: 
 

TRC  Descr  
TRC 
Type  

Earn 
Code  

Comp 
Leave 

Ind  

Add 
to 

Gross 
GIVAN  Annual Leave Given  Hours  ANG  LTKN  N 
GIVSK  Sick Hours Given  Hours  SKG  LTKN  N 

 
SHARED Leave TRCs to be used by the RECEIVING employee are: 

TRC  Descr  
TRC 
Type  

Earn 
Code  

Comp 
Leave 

Ind  

Add 
to 

Gross 
SHLTA  Shared Leave - Term ILL Adjust  Hours    CERN  Y 
SHLTR  Shared Leave - Terminally Ill  Hours    CERN  Y 
SHLAD  Shared Leave Adjustment  Hours    CERN  Y 
SHLGV  Shared Leave Given Back  Hours    CTKN  Y 
SHLNA  Shared Leave Non-Term Adjust  Hours    CERN  Y 
SHLNT  Shared Leave Non-Terminal  Hours    CERN  Y 
SHREC  Shared Leave Rec  Hours    CERN  N 
SHLVT  Shared Leave Taken  Hours  LVS  CTKN  Y 
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GIVING SHARED LEAVE – EMPLOYEE 100022 
 

The first step is moving the leave from one employee to another employee is updating the appropriate 
leave balance of the two employees involved. 
 
We will work through an example.  In our example, Employee 100022 is giving 80 hours of sick leave and 
40 hours of annual leave to employee 100001. 
 
We will take the hours out of the giving employee’s time first. 
Enter Employee ID  100022 
Enter Date:  100105 
 

Click . 
 
Self  Service > Manager > Tasks > Weekly Elapsed Time 
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WEEKLY ELAPSED TIME 
 

 
 
These are the entries to take the annual and sick leave out of the giving employee’s balances. 
 
Now – we have to post the given time to the RECEIVING employee ID balances.  We will do this on the 
following page. 
 

1.     Enter 80 hours in the 10/01 Saturday field 

2. Select GIVAN  from the TRC drop down 

list 

3. Click on Add a New Line 

4. Enter 40 hours in the 10/01 Saturday field 

5. Select GIVSK from the TRC drop down 

list 
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RECEIVING SHARED LEAVE  - EMPLOYEE 10001 
 

SELF SERVICE > MANAGER > TASKS > WEEKLY ELAPSED TIME 
 

Enter Employee ID of 100001 and Date of 10/01/05. 

Click . 

 

 
 
 
The Employee must have Shared Leave received on a previous date, before utilizing shared leave. 
 
NOTE:  Remember Shared Leave taken is a two (2) line entry in Weekly Lapse Time. 
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Self Service > Manager .> Tasks > Weekly Elapsed Time 
 

Key 120 hours into the Saturday 10/01 field. 

Select SHREC from the TRC drop down list. 

 

 
 

Click . 

The next step is running Time Admin. 
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RUNNING TIME ADMINISTRATION FOR BOTH EMPLOYEES 
 

ADMINISTER WORKFORCE > CAPTURE TIME AND LABOR > PROCESS > TIME ADMINISTRATION 
>RUN CONTROL 
 
 

 
 

Enter Employee Id 100022 Rec #1 – giving the leave 

Click on the yellow + to add another row 

Enter Employee Id 100001 – getting the leave 

Process Date is still 10/31/05 

Click yellow RUN button to submit the process 
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When the process is submitted, the system assigns a process instance.  
 

 
 

Run the process to Success and go through the usual checking of Details and the Message Log. 

Process Instance #112591 

Click Process Monitor  

hyperlink to go to the next  

page 
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EMPLOYEE 100001 – RECEIVING THE LEAVE 
 

Self Service > Manager > View.> Payable Time Detail 
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EMPLOYEE ID 100022 – GIVING THE LEAVE 
 
 

 
 

These two (2) entries will reduce the giving employee’s (100022) Annual leave balance and Sick leave 
balance respectively when it posts through Payroll and the Leave Accrual Process is run. 

We must verify that the 120 hours is available in employee 100001 SHARED Leave Balance 

.
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REVIEW COMPENSATORY TIME BALANCE FOR EMPLOYEE 100001 
 

Self Service .> Manger > View > Compensatory Time Balance – Employee 10001 
 
 

 
 
 

Now that the balance is loaded, we are ready to use the shared leave. 
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USING SHARED LEAVE – EMPLOYEE 100001 
 

Self Service > Manager > Tasks > Weekly Elapsed Time 
 

 
 

When we go back to the Weekly Elapsed Time Page starting with October 1 – we see that the SHREC – 
Shared Leave Received is still sitting there – which is very good.  

LEAVE IT ALONE!!! 

Time and Labor has set a flag behind the scenes that you cannot see that tells the system that the 
SHREC row has already BEEN PROCESSED and not to process it again.  
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Click . 

 
 

 
 

Key 8 hours a day into the Mon – Fri boxes – starting with 10/03. 
 

Select SHLVT from the Time Reporting Code drop down list. 
 

SHLVT posts the time to Employee 100001 SHARED leave balance and pays the employee for it. 
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Click  again to add another row. 
 
We must also post this time to the accumulator that we set up for it – SHLFNOTERM. 
 
We use the TRC of SHLNT to update the balance of the Shared Leave Taken because there is an upper 
limit that the State will allow per person. 
 

 
 

Click  to save your work. 
 

If you were using Shared Leave for more days in October, click  and enter the used 

days. 

 

NOTE:  Remember to  before you change weeks. 
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The next step is to run the Time Administration Process again for the month of October. 

Administer Workforce > Capture Time and Labor > Process > Time Administration 

 
 
 

We are only going to process Employee 100001 using the same date of 10/31/05. 

Run Time Administration on Process Scheduler to SUCCESS 

Check the DETAILS and the View Log/Trace Message Log when it finishes. 
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CHECK PAYABLE TIME FOR EMPLOYEE 100001 
 
Self Service > Manger > View > Payable Time Detail 
 

 
 

The SHLVT rows are marked – Estimated – Ready for Payroll. 

These lines will go onto PAYROLL and pay the employee for this time. 

 

The SHLNT rows are marked – Needs Approval (which they really don’t) and they have updated the 
SHARED LEAVE Comp Time Balance and the SHARED Leave NonTerm Accumulator (SHLFNOTERM 
Comp Time Balance). 
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CHECK SHARED COMP TIME BALANCE – EMPLOYEE 100001 
 
Self Service > Manger > View > Review Compensatory Time Balance 
 

 
 
 

SHARED Leave now shows a balance of 80 hours since it just subtracted the 40 hours from it that we 
posted. 

 

Check the accumulator balance SHLFNOTERM 

 

Click . 
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 shows the following list of this employee’s Comp Time Plans. 
 

 
 
Click on SHLFNOTERM. 
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. 
 
 
This accumulator shows a balance of 40 hours now since we posted the 40 hours through Time 
Administration.
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POSTING SHARED LEAVE TIME DOCUMENT 
 
There have been issues with transferring time from the sick and annual leave balances to the shared 
leave comp time plan.  New codes were created effective October 13 to transfer balances back from 
shared leave to the sick or annual leave balance of the original giver.  With the creation of these new 
codes…the ANNGV and SICGV codes have been removed as of October 13.   
 
Please correctly use the codes below to post and manage shared leave.  Deviation from the following will 
cause the employee leave statement and shared leave balances to be incorrect. 
 
Use these first three codes to transfer from one employee’s annual or sick balance to another 
employees shared leave balance. 
 
TRC Short 

Description 
Purpose 

 
GIVAN 

 
Give AnnLv 

 
Annual Leave Given is used to reduce the annual leave balance of an employee 
giving leave to somebody else. 
 

 
GIVSK 

 
Give SicLv 

 
Sick Leave Given is used to reduce the sick leave balance of an employee 
giving leave to somebody else. 
 

 
SHREC 

 
ShrLv Recd 

 
Shared Leave Received is used to add hours to an employees shared leave 
balance. 
 

 
Use the following two codes together to post time taken for an employee on a non-terminal shared leave.  
These two (2) codes must always be used together 
. 

 
SHLVT 

 
ShrLv Takn 

 
Shared Leave Taken is used to post time taken.  Enter a positive number to 
reduce the employees shared leave balance. 
 

 
SHLNT 

 
ShrLvNonTr 

 
Shared Leave Non-Terminal is used to track the use of the non-terminal leave.  
The limit is 2088 hours.  Enter a positive number to add to the amount of leave 
used. 
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Use the following two codes together to post time taken for an employee on a terminally ill shared leave. 
These two (2) codes must always be used together. 
 

 
SHLVT 

 
ShrLv Takn 

 
Shared Leave Taken is used to post time taken.  Enter a positive number to 
reduce the employees shared leave balance. 
 

 
SHLTR 

 
ShrLvTerm 

 
Shared Leave Terminally Ill is used to track the use of the terminal leave.  The 
limit is 2920 hours.  Enter a positive number to add to the amount of leave used. 
 

 
Use the following codes to make adjustments to the shared leave balances.  If Shared is adjusted, then 
the non-terminal or terminally ill values must also be adjusted. 
 
 
SHLAD 

 
ShrLv Adj 

 
Shared Leave Adjustment is used to add hours or reduce hours from the shared 
leave balance.  Positive numbers add to the balance, negative numbers reduce 
the balance. 
 

 
SHLNA 

 
ShrLvNTAdj 

 
Shared Leave Non-Term Adjust is used to add hours or reduce hours from the 
amount of leave used for employees on non-terminal leave. 
 

 
SHLTA 

 
ShrLvTrAdj 

 
Shared Leave –Term Ill Adjust is used to add hours or reduce hours from the 
amount of leave used for employees on terminally ill leave. 

 
When the employee returns to work use the following codes to give back any available shared leave 
balance to the employee that gave the sick or annual leave. 
 
 
SHLGV 

 
Give ShrLv 

Shared Leave Given Back is used to reduce the shared leave balance.  Enter a 
positive number to reduce the shared leave balance for the employee that was 
on the shared leave. 

 
ANREC 

 
AnnLv Recd 

Annual Leave Received is used to post annual leave time to the employee that 
originally donated it.  Enter a positive number to add hours back to the 
employees annual leave balance. 

 
SICRC 

 
SicLv Recd 

Sick Leave Received is used to post sick leave time to the employee that 
originally donated it.  Enter a positive number to add hours back to the 
employees sick leave balance. 
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PROCESSING SICK AND ANNUAL LEAVE 
 

OVERVIEW 
 
The State of Oklahoma has designed the leave process to use the Time and Labor function in 
PeopleSoft.  All annual leave and sick leave used has to be keyed into the Weekly Elapsed Time 
Page in Time and Labor and processed through Time and Labor 
 
All the sick time taken entries and annual leave taken entries must have payable time 
generated for them and the payable time has to be sent onto payroll so that the leave time 
will be posted to the leave plans and update the appropriate balances. 
 
The leave accrual process for sick leave and annual leave is run once-a-month on the next to last 
day of the month, after all the payrolls for that month have been confirmed. 
 
The State of Oklahoma has designed a Leave Statement Report that looks at Payable Time and 
selects the leave time with a status of TP (Taken by Payroll) and includes that time in the Leave 
Statement numbers.  This is the reason that sick and annual leave time taken must go through 
Time and Labor in order for the Leave Statements to be correct. 
 
Sick Leave and Annual Leave are considered part of the Base Benefits part of PeopleSoft.  We 
will enroll employees in these plans in the Base Benefits portion of the training in the afternoon.  
We will work with employees that are already enrolled in these Benefit Plans for our Time and 
Labor exercises.  The employee must be enrolled in Base Benefits, before payroll is confirmed, 
for the accrual process to be accurate. 
 
Any reversal or correction that adds back to the employee Annual or Sick Leave, must be 
approved and processed through a confirmed paycheck.  After the accrual process has been 
completed, the Annual and Sick Leave balances will be updated. 
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TIME REPORTING CODES (TRCS), SICK & ANNUAL LEAVE 
 
There is special group of TRCs for Sick and Annual Leave.  Each agency has a list of their 
specific codes.  We will use the TRC List for Agency 805 as our example. 
 

TRCS FOR ANNUAL LEAVE – AGENCY 805 

TRC  Descr  
TRC 
Type  

Earn 
Code  

Comp 
Leave 

Ind  

Add 
to 

Gross 
ANNAD  Annual Leave Adjustment  Hours  ANA  NO  N 
GIVAN  Annual Leave Given  Hours  ANG  LTKN  N 
TERM  Annual Leave Payout  Hours  ALP  NO  Y 
ANREC  Annual Leave Received  Hours  ANR  NO  N 
ANNLV  Annual Leave Salaried  Hours  ANL  LTKN  N 
ANNHR  Annual Leave Hourly  Hours  ANH  LTKN  N 

 

TRCS FOR SICK LEAVE – AGENCY 805 

TRC  Descr  
TRC 
Type  

Earn 
Code  

Comp 
Leave 

Ind  

Add 
to 

Gross 
SICAD  Sick Hours Adjustment  Hours  SCA  NO  N 
SICGV  Sick Hours Given  Hours  SCA  NO  N 
GIVSK  Sick Hours Given  Hours  SKG  LTKN  N 
WCSH  Sick Leave Hourly  Hours    NO  Y 
SICRC  Sick Leave Received  Hours  SKR  NO  N 
SCKTK  Sick Leave Salaried  Hours  SKL  LTKN  N 
WCSS  Sick Leave Salaried  Hours  SKL  NO  N 
SCKHR  Sick Leave Hourly  Hours  SKH  LTKN  N 
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ENTERING THE ANNUAL LEAVE TAKEN 
 
Employee 100078 took 8 hours of annual leave on October 5 and 6 hours of sick leave on October 
11. 
 
SELF SERVICE > MANAGER > TASKS > WEEKLY ELAPSED TIME 
 

 
 

Click . 

Key 8 hours under the Wednesday field on the new line 

Select ANNLV from the time reporting code (TRC) drop down list 

Click . 

Click . 

1 
2 3 

4 
5 
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ENTERING THE SICK LEAVE TAKEN 
 

 
 

Click . 

Key 6 into the field under Tuesday October 11 

Select SCKTK from the Time Reporting Code drop down list (TRC)  

Click . 

We have finished entering our leave time for this employee. 

Next step – Run Time Administration Process 

1 2 3 

4 
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RUN TIME ADMINISTRATION PROCESS FOR EMPLOYEE ID 100078 
 

Now – we will run the time administration process using the process date of 10/31/05. 

We will follow the same steps to process this leave through time administration as we did when we 
processed the comp time through time administration. 
 

When time administration finishes, we will check for payable time, as was done for the comp time. 
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PROCESS TO APPROVE TRCS IN ‘NEEDS 
APPROVAL’ STATUS 

 
Some Time Reporting Codes (TRCs) for sick and annual leave are being changed or deleted after being 
processed through payroll.  This then causes an offset so payroll and the leave accrual system know the 
change or deletion occurred.  However, this offset doesn’t get processed by payroll until it has been 
approved.  Below explains where this falls into the payroll process and the following pages explain in detail 
how to approve the TRCs in a “Needs Approval” (NA) payable status. 
 
There are a couple reasons TRCs end up in a Needs Approval (NA) status. 
 

1. The first and most common reason is the earned or adjusted hours for any comp time plan 
automatically go to a needs approval status.  This is built into the system and will always happen.  
There is no affect on the comp time balances if these TRCs are approved or not.  To be 
consistent you will need to approve these comp time TRCs. 

2. The second is for any TRC mapped to a payroll earning code (like ANNLV and SCKTK) that gets 
changed or deleted from Weekly Elapsed Time AFTER it has already been processed by payroll.  
These TRCs must be approved in a timely manner for the sick and annual leave balances to be 
accurate. 

 
Below is a high-level flow to show where this approval process fits into the payroll process. 
 
Process Flow: 
 

1st.  - Enter time taken and adjustments into Weekly Elapsed Time reporting page. 

2nd.  - Run Time Admin Process. 

3rd.  - Validate hours in the Estimated – Ready for Payroll status using the Payable Status Report.  
Any hours in this status will be pulled into payroll. 

4th.  - Approve TRC’s in a Needs Approval status. 

5th.  - If any corrections are needed for the hours entered, the data on Weekly Elapsed Time can be 
changed and Time Admin can be run again.  Once the payrolls are confirmed, the hours 
posted cannot be changed. 

6th.  - Process payroll. 
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Navigation: Compensate Employees > Administer Workforce > Capture Time and Labor > Manage 
> Approve Time by Group 
 

APPROVE TIME BY TIME REPORTER 
 

 
 
Group ID: Enter the agency number. 
Start Date: Enter the beginning of the month in which the conversion occurred. 
End Date: Enter the last day of the current month. 
 
Using the Approve Time by Group page you can enter your agency number and a date range to find all the 
employees that have TRCs needing to be approved. 
 
Enter a large date range (go back at least two or three months) to capture any TRCs that may have an old 
date. 
 

Click  and then select the first group in the list to see the employees that need TRCs approved. 
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From this page you can click on the More links to see the detail for each employee. 
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The detail shows the quantity for each individual TRC that needs approved. 

Click the Approve Checkbox and click . 
 

 
 

After clicking on SAVE you will be asked to confirm the Save click . 
 

 
 
Upon saving, the payable status immediately changes to Closed (for comp-time TRCs) or to Approved – 
Ready for Payroll (if the TRC feeds to payroll like ANNLV or SCKTK). 
 
The next run of payroll will pick up and process any Approved – Ready for Payroll TRCs. 
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Click the Return to GroupID link.  Process the next employee in the list.  Repeat this process until all 
time has been approved. 
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As you become more comfortable with this process or do not need to look at the detail for each employee, 
you will be able to save time by approving all employees at one time from the Approve Time by Group 
page. 
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PROCESSING LONGEVITY 
 

PARTIAL LONGEVITY 
 
The first step on the Main and Supplemental Payroll Processing Steps thru Confirm Check List is running 
the Longevity Part-time Process. 
 
Reports Menu > OCP Reports > PY > MDC Lgvty Cmp (0024) 
 
This step produces a report listing all the employees for the agency that would be eligible for a partial 
longevity.  The payroll user must take this report and manually calculate the amount of Longevity the 
employee should be paid. 
 

 
 
The payroll user takes the amount of money that the employee is due for his partial longevity and keys it 
into the Weekly Elapsed time entry page on the day it is to be paid.  Longevity is posted usually on the last 
day of the month as the following example illustrates. 
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Self Service > Manager > Tasks > Weekly Elapsed Time 
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LONGEVITY PAYOUT – FIRST LONGEVITY PROCESS – STEP 2 
 
The second step on the Main Payroll Checklist is to run the First Longevity Process.  This process 
produces a report and it updates Weekly Elapsed Time on the last day of the month with the LONGV Time 
Reporting Code and the amount of money that is owed the employee. 
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NEXT YEAR LONGEVITY – 2ND LONGEVITY PROCESS - STEP 10 
 

 

 
The Next Year Longevity shows on the payroll side as an SPC – earnings code.  SPC – next year 
longevity is used in the formula for paying overtime at time ½. 
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PROCESSING TERMINAL LEAVE PAYOUT 
 

STEP 1 – ENTERING TIME INTO ELAPSED TIME 
 
 
1. Key the number of hours the terminated employee is to be paid in Weekly Elapsed Time 

 
Self Service > Manager > Tasks > Weekly Elapsed Time 

 
Select TRC of TERM.  Enter the hours on a date when the employee was ACTIVE.  The 
last day this employee worked was 12/15/05 so his JOB Data record shows termination date 
of 12/16/05. 
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STEP 2 - RUN TIME ADMINISTRATION BY EMPLOYEE ID 
 
The Process Date on the run control for Time Administration should be the Last Date that the 
employee was ACTIVE. 

 

 
 

Example – Employee A’s last day to work was 12/15/05 HR should terminate the 
employee as of 12/16/05 
 
The process date on the Time Administration Run Control would be 12/15/05. 

 
Your run control may be showing only a line with Group ID in it. 

 

Click   on the right at the end of the line and the system will refresh that line 
and open up all the boxes – including the Employee ID box.  Enter the Employee ID that 
you are processing. 
 

Run the process by clicking  button. 
 

Last day the  
employee 
was active 
 

Employee ID that 
was terminated 
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2. Check the Message Log and be sure the 3rd line from the bottom of the report is  BLANK and 
does not say “No employees to process”.  This message means that you did not process 
any employees successfully. 

 
 So – you need to check for time and labor exceptions.  Go to Step 4. 
 
 If the 3rd line from the bottom of the report is a blank line, employees were processed.  Go to 

Step 5. 
 

3. Check for Time and Labor Exceptions. 
 

Administer Workforce > Capture Time and Labor > Manage > Manage Group 
Exceptions 

 
Enter Group ID – XXX01 if you are processing Salaried people 
 XXX02 if you are processing the other group 

 

Click . 
 

You are hoping for ‘No matching values were found.’ message which means you do not 
have any errors 
 
You can also check exceptions by Employee ID. 

 
Administer Workforce > Capture Time and Labor > Manage > Manage Exceptions 

 

Enter Employee ID and click . 
 

You are hoping for ‘No matching values were found.’ message which means you do not 
have any errors 

 



 

COR106 Time and Labor Manual Page 125 of 129 
Revised: April 15, 2008 

CORE Oklahoma 
 

STEP 3 - CHECK PAYABLE TIME DETAIL  
 
Be sure that the time says – Estimated – Ready for Payroll 
 

Self Service > Manager > View > Payable Time Detail 
 

Enter the Employee ID and the EXACT date the time was entered and click . 
 

 
 

This time will be picked up 
automatically by payroll 
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STEP 4 - GO_PAY_TIME_BY_PAY_PERIOD 
 

PeopleTools > Query Manager > Use > Query Manager > in the box where the cursor is 

blinking enter GO_PAY_TIME_BY_PAY_PERIOD  and click . 
 

Click . 
 

The prompt asks for Agency – enter your 3 digit agency number and date range 
 

Click . 
 
           

ES – Estimated 

Payable Time – 
Ready for Payroll 
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ADJUST PAID TIME 
CLOSING REJECTED ROWS 
 

As we know, time is entered into Weekly Elapsed Time, the Time Administration batch job is run, and 
Payable Time is produced with a Payable Status of ES – Estimated, Ready for Payroll.  If changes need to 
be made before the data is loaded to Payroll, it can be changed in the Weekly Elapsed Time page, re-run 
Time Administration, and the Payable Time row will be updated.  
 

If the status of the Payable Time row is Closed, Sent to Payroll, Taken by Payroll or Rejected by Payroll, 
Time Administration will create an off-setting entry in Payable Time if the original time is modified through 
the Weekly Elapsed Time page. 
 

Closing Rejected Rows: 
 

If the Payable Time status is Rejected by Payroll, those rows of data can be closed. 
 

To close Rejected rows, navigate to the Adjust Paid Time Page. 
 

NOTE:  Be cautious when you close annual or sick leave that has been rejected, and not pulled through 
payroll, can put you out of balance with your accrual balances, and this action cannot be reversed.  
Closing a transaction is used for specific errors and clean up. 
 

Home > Administer Workforce > Capture Time and Labor > Manage > Adjust Paid Time 
 

Enter the Employee ID, start date and end date then click . 
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Click the ‘Close?’ Checkbox for the row(s) you want to close and click . 
 

 
 

The entry will disappear from this screen after you click .  However, it will continue to show on 
the Payable Time Detail Screen.  The Payable Time Detail Screen does not show the status of each line 
so you cannot tell from looking at that screen that you have closed the transaction. 
 
Closing the time will stop the system from attempting to send it to Payroll every time that Payroll pulls 
transactions or Time and Labor loads transactions.  If it cannot load to payroll, the system produces 
Payroll Error Messages. 
 
 

NOTE: The Payable Status can be checked by using the Payable Time Detail Page.  Any row with an RP 
Rejected by Payroll status would be reloaded into Payroll provided the employee is within the Paygroup 
and the date of the Payable Time is less than or equal to the Pay End Date.  However, with this 
functionality there is no way of knowing through an inquiry page, if the Rejected rows will be loaded to 
payroll, since those that were closed through the Adjust Paid Time page will not be. 
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PROCESSING ADJUSTMENTS THRU T & L 
 
All adjustments are made through the weekly elapsed time page.  Use the appropriate adjustment code.  
When entering the value (hours or amounts) for the TRC, a positive amount will pay or add to leave 
balances.  A negative number will need to be entered to reduce pay or leave balances.  This is different 
then entering leave time taken because the TRCs for taking time off are configured to subtract from the 
appropriate balances when a positive value is used on weekly elapsed time.  However, adjustments are 
configured to add to the balances if the number is positive. 
 
TRCs for Adjustments 

TRC  Descr  
TRC 
Type  

Earn 
Code  

Comp 
Leave 

Ind  

Add 
to 

Gross 
ANNAD  Annual Leave Adjustment  Hours  ANA  NO  N 
ADLAD   Admin Lv Cool Off Adjustment   H       CERN   Y 
ADJ   Earnings Adjustments   H   ADJ   NO   Y 
CADJ   Comp Rate Adj (Mid Week)   H   CAJ   NO   Y 
CTEAD   Comp Time Earn Adjustment   H       CERN   Y 
ENFAD   Enforced Leave Adjustment   H       CERN   Y 
EQUIT   Equity Based Pay Adjustment   A   EBP   NO   Y 
HOLAD   Holiday Leave Adjustment   H       CERN   Y 
LATXF   Lateral Transfer Adjustment   A   LAT   NO   Y 
MILAD   Military Leave Adjustment   H       CERN   Y 
ORGAD   Organizational Leave Adjustmen   H       CERN   Y 
RADJ   Retro Pay Adjustment   A   RAJ   NO   Y 
SHLAD   Shared Leave Adjustment   H       CERN   Y 
SHLNA   Shared Leave Non-Term Adjust   H       CERN   Y 
SHLTA   Shared Leave - Term ILL Adjust   H       CERN   Y 
SICAD   Sick Hours Adjustment   H   SCA   NO   N 

 


